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Contents of the OPTi package 
 

• The OPTi Lite unit with integrated base 

and USB cable 

• Charger with mains lead 

• Carry case 

• OPTi CDROM with application  

• The User’s manual 

• Installation guide 

• Quick reference guide 

 

Installation 
The OPTi requires that you first 
carry out the software installation 

before plugging the unit into your 

computer.  Please refer to the installation 

guide before continuing. 

 

Charging OPTi Lite 
OPTi Lite contains a rechargeable battery 

which must be charged periodically if you 
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want to use it on the move.  Simply plug 

the charger into the base of the unit and a 

wall socket and leave it to charge.  The 

battery will be fully charged in 4 hours and 

should last approximately 10 hours of 

usage. The unit can be used while it is 
charging.  

 

 

 

OPTi software 
The OPTi software consists of the video 

window and the toolbar. The video window 

displays the real time video image 

captured by the unit itself. The video 

window is movable and resizable both 

horizontally and vertically.  

 

The toolbar window displays the main 

controls for the software. This allows you 

quick access to the video control features 

and to the main menu. 
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As you move text or an image under the 

OPTi’s camera, the image will be displayed 

on the video window. There are many 

features on the OPTi software that allow 

you to optimise the display for your 

particular requirements. 

 

Shortcut keys in this manual are 

described in the form “Ctrl+X”. 

This means that you press and hold 

the control key and press the letter (“X”).  

 

The shortcut keys only have effect when 

OPTi is the active program; they are not 

trapped by OPTi and may have another 

function entirely in other programs.  

 

The one exception to this is the Scroll-Lock 

button, this button is trapped by OPTi. 

Pressing this button will make OPTi the 

active application, and so OPTi will appear 

on top of any other program that is 

running.  
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The toolbar explained 

The following section explains function of 

the buttons on the OPTi toolbar. The 

complete toolbar is illustrated below. 
 

 
 

Each of the buttons functions is explained 

in this section along with their equivalent 

keyboard shortcuts. On OPTi Lite it is also 

possible to program the control panel 

buttons to perform some of these 

functions. This allows you three ways to 

control OPTi, the PC mouse, the PC 

keyboard and the control panel on the 

front of the unit itself. 

 

Keep on Top     

Toolbar:  

Keyboard: Ctrl+T 

“Keep on top” forces the OPTi video 

window on top of any other program 
window. For example, in the image on the 

next page the user is typing in MS Word 

but the OPTi video window is sitting ‘on 
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top’ of MS Word and is visible even though 

Word is the active application. 

 

 

  

Sleep mode On/Off  

Toolbar:  

Keyboard: Ctrl + S 

The Sleep mode function on OPTi is similar 

to the screensaver function on a PC. If you 

don’t think you are going to use your OPTi 

for a while but want to leave the program 

running, you can save battery power by 

simply putting OPTi into Sleep mode. This 

causes the video window to disappear and 

turns off OPTi’s internal circuitry.  
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Full Screen 

Toolbar:  

Keyboard: Ctrl+F 

When OPTi is in full screen mode the video 

window takes up the entire screen and 

only the toolbar window will be visible over 

the video window.  

 

Views and the Views Manager 

Toolbar:  to cycle 

Keyboard: Ctrl + Shift + 0…9 to save 

 Ctrl + 0…9 to recall 

 Ctrl + V to cycle the views 

When you have set up the display the way 

you want it, you can store the settings for 
later recall. In fact you can store ten 

arrangements or “views” which can be 

recalled as you desire. 

 

When you start the program for the first 

time all ten views will be at the default 

setting.  
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If you make a change to a view you can 

store it as one of the ten views (View 0 to 

View 9) as follows:  

 

Ctrl + Shift + 0 to save as view 0 

Ctrl + Shift + 1 to save as view 1 

and so on up to  

Ctrl + Shift + 9 to save as view 9 

 

You will be prompted to confirm that you 

wish to save the current layout. 

 

Note that you cannot store a 

setting at full screen. You should 

instead use Page Up to enlarge the 

window to the maximum size and then 

save this instead.  

  

To recall the stored views, press Ctrl + 0 

to Ctrl + 9. You will be prompted to save 

any changes you made to the current view 

when you change to another view. 
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You can use the Views Manager to look at 

the views you have stored. You can access 

this from the menu by pressing the Menu 

button  (see page 17), then “Views” and 

then “Views Manager”.   Choosing view 0 

to 9 will display a preview of the view as it 
would appear on the screen in the colours 

stored for that view. You can choose OK to 

select a view.  The image below shows a 

screen grab of the Views Manager. 

 

The “Replace with current view” button will 

store the current screen layout into the 

selected view. In the case above, view 1 

would be replaced with the current view. 

The “Include in window cycle” checkbox 

can be set for each of the ten views. If this 

box is checked for a particular view then 

that view will be displayed in rotation as 
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you cycle through the views with the  

button on the toolbar or by pressing Ctrl + 
V on the keyboard, or alternatively with 

one of the front panel buttons pro-

grammed to cycle views. (Programming 

the front panel buttons is covered later in 

this manual.) 

 

Video controls       

Toolbar:  

The video controls allow you to control the 

brightness and contrast and saturation of 

the OPTi image. Press  on the toolbar or 

from the menu by pressing the menu 

button  (see page 17) choose “Options”, 

“Video controls” (Keyboard: Ctrl + M, O, 

V). The Video controls dialog box is shown 

below will appear. 
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The slider controls can be adjusted as you 

desire. You can use the mouse to move 

them or you can use the keyboard. For 

example to change the brightness of the 

image, press “B” and then use the arrow 

keys on your keyboard to move the slider 
left and right. Once you are happy with the 

settings press OK or press “Enter”.  The 

“Faint text”, “Normal text” and “Shaded 

text” buttons allow you to store settings 

that are best suited for viewing text in 

those conditions.  

For example if you are reading very faint 

text you may want to turn down the 

contrast. When you are happy with the 

image press the “Save As” button 

(Keyboard: A) you will see the following 

dialog box: 

 

If you then press the “Faint” button 

(Keyboard: F) your video settings will be 

stored, and the next time you are viewing 
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faint text you can recall them by pressing 

the “Faint text” button on the video 

settings dialog. 

 

The video settings for Photo, Positive and 

Negative are independent of each other. 
Also these settings are saved with each 

view. 

 

Lights On/Off         

Toolbar:  

Keyboard: Ctrl + L 

OPTi Lite is equipped with an integrated 

light that can be turned on or off as 

desired. The light can be controlled using 

the  button on the toolbar or from the 

menu by pressing the menu button  (see 
page 17) choose “Lights” and from there 

choose to turn them on or off. 

 

Capture 

Toolbar:  

Keyboard: Ctrl + C 
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The capture button allows you to take a 

photograph of the image currently being 

displayed on OPTi’s video window. The 

image is saved as a .bmp file into a folder 

on your computer hard drive. The folder is 

created automatically when you install the 
software. It is located in the “My Pictures” 

folder on your computer and is called “OPTi 

Images”. It is advisable to create a 

shortcut to this folder on your desktop. 

To operate the snapshot you can press the 

 button or from the keyboard press 

Ctrl+C. 

 

The OPTi Images folder is created 

when the software is installed. It is 

very important that you do not 

move or rename this folder. If you do then 

the snapshot function will not work. 

 

Images are saved as “OPTiImg001.bmp”. 

Every time you take an image the file 

name increments. The screen grab shows 

how the folder will look after several 

snapshots have been taken. 
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As you can see the file name increments 

by 1 each time a picture is taken. 

 

Hide toolbar 

Toolbar:  

The hide toolbar button allows you to 

remove the toolbar from the display. This 

is useful if you want to view in full screen 

with nothing else visible. You can bring the 

toolbar back by clicking on the OPTi icon in 
the system tray as show in the screen grab 

below. 

 

Alternatively, if you put the mouse cursor 

on the video display and right click the 

main menu will appear. From this choose 
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“Options”, “Preferences” and then in the 

Preferences dialog box you can select 

where you wish the toolbar to be placed. 

(Keyboard: Ctrl+M,O,P) 

(OPTi’s preferences menu will be explained 

in the next section) 

 

Exit Program 

Toolbar:  

Keyboard: Alt + F4 

This button can be used to exit the 

program. Alternatively you can use the 

menu by pressing the menu button  (see 

page 17) and choose “File” “Exit” or by 

pressing Alt+F4. 

 

Main menu 

Toolbar:  

Keyboard: Ctrl + M 

 

All of OPTi Lite’s features can be accessed 

from its popup menu. To display the menu, 

press the  button on the toolbar or right 
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clicking on the video window. You can also 

access the main menu from the keyboard 

by pressing Ctrl + M. 

The main menu allows you to access all of 

the program features and appears as 

follows: 

 

Each of the submenus allows you to access 

different features in the software. Most of 

these functions are accessible directly from 

the toolbar, but some are not. The menu 

functions are explained below. 

 

File 

The File submenu allows you to put OPTi 

into Sleep mode, enable or disable the 

Keep on top feature or to Exit the 

program.  
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View 

The View submenu allows you to select the 

view you wish to use. This is an alternative 

to pressing Ctrl+0, Ctrl+1 and so on. You 

can also access the Views Manager dialog 

box from here.  Refer to the section on the 

views manager on page 11 

 

Options 

The Options submenu allows you to access 

the Video Controls, Preferences Button 

functions, Colours and Markers.   Video 

Controls have been described on page 12 

and the subsequent sections will detail the 

operation of the Preferences, Button 

functions, Colours and Markers.  

 

Options … Preferences 

From the menu choose “Options”, 

“Preferences” (Keyboard: Ctrl + M,O,P) 

The preferences menu appears as follows; 
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• You can use the “Toolbar” controls to 

select where the toolbar is displayed. 

Note that the “Screen top left” and 

“Screen top right” deliberately leave 

room for the Windows control buttons. 

Choosing “Video window” will attach the 

toolbar to the top left of the display 

window. You can also choose to hide 

the toolbar. 

 

• If you do not want to be prompted to 

save changes to the current view you 

can choose to automatically accept or 
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reject all changes with the “Changes to 

Views” option you select. 

 

• OPTi can display the toolbar in three 

different sizes, these are normal, large 

and extra large, the image below shows 
a comparison of how these appear from 

smallest to largest 

 

• ToolTips may be turned off by un-

checking the ToolTips checkbox. 

• Un-checking the “Lock Aspect Ratio” 

will allow the video to be stretched to 

fill the display window. If the display 

window is set to be taller than wide the 

video will appear in tall, skinny 

characters. If the display is much wider 

than tall the video will appear fatter 

than normal. This setting may produce 

an image that is easier to read for 

certain eye conditions.  
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The “Advanced” button opens up another 

window with the following options; 

 

This menu allows you to crop the video 

image, to boost the size of the displayed 

text by 10% and to automatically detect 

screen magnification programs. In normal 

use these settings are not needed when 

you are using OPTi. 

 

Options … Button Functions 

OPTi Lite has two buttons on the front of 

the control panel marked as “ ” and “#”. 

These buttons can be programmed to 

perform one of a number of functions. 

From the menu choose “Options”, “Button 

Functions” (Keyboard: Ctrl+ M, O, B). 

This window appears as follows: 
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Use the mouse to choose the function you 
desire for the “ ” button the “#” button, or 

for both buttons pressed together. You can 

also use the keyboard to program the 

buttons, for example, pressing “C” on the 

keyboard programs the “ ” button to turn 

the lights on or off when you press it. By 
pressing “W” on the keyboard the “#” 

button is programmed to turn on or off full 

screen mode when you press it. The image 

below shows the location of the buttons on 

the control panel. 

OPTi #

 

The functions you can program the buttons 

to do are self-explanatory with the 
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exception of “Switch to OPTi and back”. 

This is equivalent to pressing scroll lock on 

the keyboard. 

 

Options … Colours 

The colours used to display the text and 

paper can be altered. From the menu 

choose “Options” and “Colours” (Keyboard: 

Ctrl+ M, O ,V). A dialog box appears as 

follows: 

 

From the dialog box above you can choose 

the foreground and background colour that 

you require. You cannot select the same 

foreground and background colour. If you 
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are using the keyboard, you can switch 

between the colours by using the Tab key.  

Alternatively you can select the required 

foreground or background colour from the 

keyboard. Use Alt + ����, ����, ,  to cycle 

between the available colours.  

You must be in Positive or Negative mode 

for this menu to work. You cannot change 

the foreground and background colours 

when you have the unit in full colour 

mode. 

Options … Markers 

OPTi also has an adjustable reading line 

and line marker that you can turn on and 

off as required. From the menu choose 
“Options” ,“Markers” (Keyboard: Ctrl + H) 

The dialog box shown below will then 

appear. 
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The position of the line or the line marker 

is adjustable from the keyboard using 

Ctrl+ PgUp or Ctrl+ PgDn. The images 

below show how these features appear 

when viewing text. 

         

Lights  

This submenu allows you to turn on or off 
the integrated light. 

 

Help 

The help submenu allows you to access the 

online help, (Keyboard:  F1), reset the 

programme to factory defaults and view 

the About window.  

 

OPTi Lite Control panel 
As explained in the previous section the 

OPTi Lite has two buttons on the front 

panel that can be programmed to perform 
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a number of different functions. The front 

panel also has a circular switch on the 

front. This switch is used to select between 

full colour mode and one of two high 

contrast modes. The images below 

illustrate this operation. 

 

OPTi #

OPT i
#

Full Colour

OPT i #

High contrast

Negative

High contrast

Positive
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Image Quality 

The quality of the video displayed on the 

OPTi screen can be controlled using the 

Image Quality window. You can access this 

by pressing Shift+N on the keyboard. The 

window appears as follows on the desktop: 

 

 
Image quality control window 

 

There are six levels of quality 

enhancement available to the user, 

starting at No Enhancement and 

progressing to Level 5 enhancement. OPTi 

defaults to Level 3 enhancement. This 

gives excellent image quality with very 

little impact on PC resources.  

 

To change the image enhancement setting 

simply select the level you desire and click 

on OK. The OPTi image will disappear from 

the desktop for about 4 seconds before 

reappearing. When video reappears OPTi 
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will be operating at the new image setting. 

The image enhancement control affects 

how the OPTi image appears when the 

camera or the object of interest is moving.  

 

OPTi and Screen Magnification 

software 
 

OPTi Vista Versions 1.2 and above are 

compatible with the following screen 

magnification software: 

 

BRAND PRODUCT 
Dolphin Oceanic Supernova V8.01 and above 

AI Squared ZoomText V9.1 and above 

 

OPTi works differently when it is running in 

screen magnification mode. This section 

describes how to use OPTi with screen 

magnification software. 

 

When OPTi starts it checks to see if any 

supported screen magnification programs 

are currently running, if they are the 

software will change from normal mode to 

compatible mode during start up.  
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Once OPTi detects the screen magnification 

software it adjusts its settings to those 

required for operation with screen 

magnification on.  

 

AI Squared: ZoomText 

If ZoomText is active on the User’s 

computer then OPTi will start-up with the 

toolbar visible as shown: 

 

 
 

The toolbar only has the stop/exit 

application button available. 

 

An information box appears indicating to 

the user that magnification needs to be 

turned off for OPTi to become available: 
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The OPTi will only operate when ZoomText 

magnification is turned off. OPTi can start 

up while ZoomText is running but unless 

magnification is turned off the OPTi video 

window and fully functional toolbar will not 

be available. When magnification is turned 
off the OPTi video window appears and full 

toolbar functionality is made available. 

 

Dolphin: Supernova 

If Supernova is active on the User’s 

computer then OPTi will start-up in Sleep 

Mode with the toolbar visible as shown: 

 

 
 

The toolbar will appear with limited 

functionality available. The only available 

functions are sleep, hide toolbar and exit. 

 

When in this mode you either have the 

screen filled with OPTi video or with the 

desktop. To swap between the OPTi video 

window and the desktop you simply press 

the Sleep toolbar button or hotkey. The 
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following image illustrates how this will 

appear. 

 

  
 

The toolbar is hidden in fullscreen mode 

although the user can use the hotkey 

functions or unit buttons to operate the 

OPTI. 

 

 To swap between the OPTi video and 

the desktop you simply press the 

Sleep button/hotkey (Page 12) 

 

 

OPTi Sounds 

This version of OPTi software is able to 

make sounds to indicate when it is the 

active application. The purpose behind this 

is to give an audible indication when you 

press the Scroll-Lock of whether you are 
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making OPTi the active application or not. 

There are two different types of sound 

available depending on the state of “Use 

external speakers for OPTi sounds” 

checkbox in the Preferences � Advanced 

menu.  

 

If this box is ticked, then OPTi will use any 

external speakers you have connected to 

emit a double note when you press Scroll-

Lock and make it the active application, 

and a single note when you press Scroll-
Lock and stop OPTi from being the active 

application. This setting is useful for a 

desktop PC with no internal speaker to 

make sounds. 

If this box is not ticked OPTi will use the 
internal speaker on your computer. In this 

case OPTi will emit a “Buh – Dee” note 

when OPTi is being made the active 

application and a “Dee – Buh” note when 

OPTi is no longer the active application. 

This setting is useful for a portable laptop 

computer with no external speakers 

hooked in. 
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Looking at the Advanced menu in the 

image below, the two settings related to 

OPTi sounds are circled in red. 

 

 
 

OPTi Preferences ���� Advanced menu 

 

The second checkbox simply stop’s OPTi 

from making any sounds at all regardless 

of what state the “Use external 

speakers for OPTi sounds” checkbox is 

in. 

 

 

 

Adjusting the Magnification 
The magnification is determined by the 

height of the camera above the reading 
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material.  The best way to adjust this is to 

place one hand firmly on the tabletop, and 

raise or lower the camera with your other 

hand as in the diagram below.  

 

  

ABC
ABC

ABCDEFGHIJ
ABCDEFGHIJ
ABCDEFGHIJ
ABCDEFGHIJ

 

 

Lower the camera for higher magnification; 

raise it to reduce the magnification.   

 

Use the lowest magnification you are 

comfortable with because: 

It is easier to locate your position on the 

page; 

There is less need to move a book on the 

table; 

The focus will work over a greater depth.  
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Adjusting the Focus 
If you change the height of the camera, or 

if the thickness of the material being read 

is changed, you will need to re-focus the 

camera.  Rotate the focus control on the 

top of the unit until the image is at its 

sharpest.  The direction of rotation is 

unimportant. 

 

Reading with OPTi Lite 

Place the material you wish to read on the 

reading table and adjust the focus knob 

until a sharp image is obtained.  Adjust the 

magnification as described above to suit 

and re-focus if necessary.  Ensure the 
camera head is horizontal for optimum 

image quality. 

 

Move the book on the table until you locate 

the top of the page and then locate the 

start of the text.  Simply slide the book 

side to side and watch the computer 

screen while reading. 
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There is a mat provided with your OPTi Lite 

to facilitate reading heavier materials.  

Place the mat across the reading table with 

the rubber side upwards.  Place the book 

on the mat and slide the mat from side to 

side. 
 

 

Place mat rubber side up

Slide the mat across the table  
 

Writing 

Remove the mat from the table.  Place the 
page under the camera and locate the area 

of the page where you wish to start 

writing.  Holding the page firmly, bring 

your pen, raised well above the paper, 

until the nib is visible on the screen at the 

point you wish to write.  Lower the pen to 

the paper carefully and write.  You should 

watch the screen as you write. 
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Hints and Tips 

Locating the OPTi Lite camera in a well-lit 

area will enhance the image available from 

the unit.  If possible, avoid direct overhead 

lighting as this can cause shadows on the 

page leading to shading differences on the 

screen. 

 

If you require subdued lighting, you should 

switch on the lights, otherwise the picture 

will become noisy. 

 

When using glossy paper, tilt the camera 

head upwards slowly until the reflections 

move off the screen. 

Taking Care of your OPTi Lite 
Do not touch the lens.  Dirt on the lens will 

appear as a blurred or dim image or as 

fuzzy spots on the screen.  If you believe 

the lens is dirty, it can be cleaned with a 

soft, dry cloth applying minimal pressure.  

As the lens is polished and coated, do not 

use a wet or coarse cloth, detergents, 

abrasive substances or solvents to clean it. 



OPTi Lite User Manual 

Page 39 

 

When transporting the unit we recommend 

that you use the carrying case provided.  

Do not allow the charger or cables to move 

about within the case, as they may cause 

damage.   
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Warranty 
Ash Technologies warrants the equipment, when purchased new, to 

be free from defects in material and workmanship and will repair or 
replace at Ash Technologies' discretion, any equipment which 
exhibits such defects, provided that the equipment has been 
operated under the proper conditions of installation and has not 

been tampered with by any persons not authorized by Ash 
Technologies or its agents and that it is solely serviced by Ash 

Technologies or its agents.  This warranty shall be voided in the 
event of damage or abuse to the unit caused, in the opinion of Ash 

Technologies or its agents, by general wear and tear, abuse, 
neglect, failure to observe stated precautions or by dropping the 

unit. 
 
Batteries are warranted for failure within a period of one year.  
Non-electrical accessories are specifically excluded from warranty. 

 
In no event shall Ash Technologies, or its agents, be liable for 
special, indirect, incidental or consequential damages; the original 
user's remedies being limited to repair or replacement. 

 
Ash Technologies makes no other or further warranty, express or 
implied, including and warranty of fitness for a specific purpose or 
warranty of merchantability. 
 

This warranty is valid for a period of TWO YEARS effective 
from the date of delivery to the customer.   

 
Depending on the country of sale, the warranty conditions may 

differ.  Contact your distributor for details.  

 

For warranty claims or service during or after 

warranty period please contact your distributor. 
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DECLARATION OF CONFORMITY 
 

We, Ash Technologies Ltd., declare under our sole responsibility that this 

product, OPTi Lite, of the brand Ash Technologies to which this 

declaration relates, is in conformity with the following standards or other 

normative documents: 

 

EN 60601-1 Medical Electrical Equipment - Safety 

EN 60601-1-2:2001 Medical Electrical Equipment – Electromagnetic 

Compatibility 

 

Following the provisions of EMC directive 89/336/EEC and Low Voltage 

directive 73/23/EEC and the provisions of 93/42/EEC Medical electrical 

equipment directive.  

 

 

Alan Johnston 

Engineering Director 

Ash Technologies Ltd, Naas, Ireland.   

24
th

 April 2006 
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